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Installation and Set-up
Manual

Before you commence using the Multilink System you need to set-up all of its components

Once set up the Multilink System will guarantee your success in real estate

Multilink Systems Pty Ltd (03) 9425 9400







Multilink Systems -

the 'turn-key' plug-&-play real estate
mentor system

Multilink Systems consists of 9 Integrated programs that can
be individually tailored to every agents needs.

The System has been Certified ISO9002 (World's Best
Practice)

Itis

A Multiple Listing System

A Multi-Loading Internet System

An IDX (Internet Data Exchange) System
A Contact Management System

A Buyer Management System

A Purchaser Management System

A Vendor Management System

A Potential Seller Management System
A Past Client Management System

An Advertising Management System

A Sales Trust Management System

A Sales Team Management System

A Referral Management System

A Sales History Management System
A Prospecting System

A Valuation System
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Foreword

Foreword

The only way successful agents can duplicate their
efforts is to have a powerful assistant and the tools
to perform.

Multilink System is the tool that seamlessly
integrates sales people and their PAs. It sets tasks,
automates procedures and monitors outputs.

The Multilink System links Office Servers,
Workstations and Laptops enabling the Sales Team
and their Administrators to effortlessly interact.

It multiloads to all Internet Sites, sends SMS Text
Messages, emails E-Brochures, matches Buyers
and Sellers, manages leads, monitors the sales
team and automates office procedures. It links your
office with Strategic Alliances of your choice to
broaden your distribution. It receives listings from
other offices and downloads 'real time' sales
information for your trading area.

Multilink is a total 'turn key' solution for a real estate
office covering everything from Prospecting, through
Listing Presentation, the management of Buyers and
Sellers (pre sale), Purchasers and Sellers (After
Exchange) and After Settlement. It manages the
Sales Team, Advertising Expenditures and Trust
Monies.

Even the marketing of Rental Properties including
communications with Tenants and Landlords is
included.

Because Multilink is modular it's users can use as
little or as many of its features as they require.

In a no nonsence way the Multilink System defines
your market, structures your company and develops
a culture and a level of professionalism that creates
for its users a well oiled and exciting real estate
enterprise with new found prosperity.
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Multilink Systems - Install and Setup

INSTALLATION

INSTALLATION: on OFFICE SERVER

Open > My Computer > right click on Local Disk (C:) Drive > Properties > under the
'General' tab check that there is enough Free space = (1GB on server) > Check that the file
system is NTFS

Start > Control Panel > Display > 'Settings' tab > check that Color Quality = (Medium 16bit)
> 'Advanced' button > check DPI Setting = Normal Size > OK > OK

In Control Panel go to 'Regional and Language Options' > check that English (Australian) is
the default language. Also check in 'Advanced’, 'Set Default' button, 'Input Locales' tab, if
they are available.

Check 'All Programs' looking for 'RE Office' C:\macpro or 'reoffice’ or 'borland'. If any of
these name appear please contact Multilink Systems before commencing Install.

Insert '‘Multilink Install Disc' > follow instructions making sure you activate 'Server' when the
question is asked. Sometimes the installation says that "there is not enough space on drice C:
Install to this location anyway?" If you have previously checked that there is at least 1GB
available — ignore this message and click "Yes' > a new dialogue box will appear saying "The
specified directory does not exist. Create it?" - click "Yes'.. Finish the Installation.

Click on to the 'Proplink’ logo that is now located on your '‘Desktop’ (or go 'Start' > 'All
Programs' > 'Multilink Systems' > 'Proplink’) > a 'Setup' dialogue box appears saying
"Proplink will now set up some parameters” > click Next > You will now be asked to type in
your Company Details (all questions must be answered) > the system will ask you for a
‘Transfer Password' > type in abcde > Type in 'User Details' (remember 'User' name is admin
and the password is abcde) > OK > a new dialogue box will appear asking "Do you belong to
a Group that is a current user of this service?"

If the answer to the question is:

"Yes' > the install program will automatically install your ‘Office ID' but the connection to
your '‘Branch' and 'Group’ will need to be done manually > you will be asked you to insert
your '‘Branch’' 'Message and Key' followed by your 'Group' 'Message and Key'. To receive
your '‘Branch' and 'Group’ IDs you will need to contact Multilink Systems (please email a
request for your '‘Branch’ 'Message and Key' and your 'Group' 'Message and Key' to info@
multilink.com.au). Your two 'Message and Keys' will be returned to you by email > First copy
and paste your 'Branch' Message and Key > OK > and then copy and paste your '‘Group’
Message and Key - this action links your 'Office’ to your 'Branch' network and also to your
'Group' network > after inserting the 'Messages & Key' follow the on-screen prompts

'No" > the install program will automatically connect to the Internet and install your 'Office’,
'‘Branch' and 'Group' IDs > follow the prompts until Set-up is complete.

If the Internet connection fails then you will need to install the IDs manually. To receive your
'Office’, '‘Branch' and 'Group' IDs manually (please email a request for your 'Office’ ‘Message
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INSTALLATION 3

and Key', 'Branch’' 'Message and Key' and your 'Group' ‘Message and Key' to info@
multilink.com.au). Your three 'Message and Keys' will be returned to you by email > Copy
and Paste them where required. After inserting the 'Messages & Key' follow the on-screen
prompts.

Log in to Proplink > type in admin 'Admin’, ‘abcde’ > Maintenance > Transfers > Transfer.
After Transfer check the log to see that Transfer was successful. Test other Muiltilink
Systems programs to see that they are all working > Start > Programs > Multilink Systems >
systematically open all of the other modules in the Multilink System suite with the same User
Name and Password ‘admin’, ‘abcde".

INSTALLATION: on WORK STATIONS

Copy the Install Files to the Server Hard Disc so that you don't have to use the Install CD
every time you want to add a 'Workstation' by > Insert 'Install CD' > click 'No' > My
Computer > Right Click on CD Drive > Explore > copy the 2 files from the CD > locate the
‘Shared Folder' on the Server > create a new folder in that Shared Folder and call it
'Proplink_Setup' > Paste the copied files in to this folder > find out the computer name for the
Server by > Start > Control Panel > System > '‘Computer Name' tab (if the Server Computer
name has a . and then an extension, only use the word that appears before the .) > Copy the
Server Name on a piece of paper > go to the first workstation > Check the available space as
previous

Open > My Computer > right click on Local Disk (C:) Drive > Properties > under the
‘General' tab check that there is enough Free space = (1GB on server) > Check that the file
system is NTFS

Start > Control Panel > Display > 'Settings' tab > check that Color Quality = (Medium 16bit)
> 'Advanced' button > check DPI Setting = Normal Size > OK > OK

In Control Panel go to 'Regional and Language Options' > check that English (Australian) is
the default language. Also check in 'Advanced’, 'Set Default' button, 'Input Locales' tab, if
they are available.

Check 'All Programs' looking for 'RE Office' C:\macpro or 'reoffice’ or 'borland'. If any of
these name appear please contact Multilink Systems before commencing Install.

Start > Run > type \\theservername > OK > when the Server opens up look for the folder
'Proplink_Setup’ > Run the Setup file > follow instructions making sure you activate the
"Workstation' radio button when the question is asked. Sometimes the installation says that
there is not enough room — ignore this and click "Yes'. Finish the Installation > set screen to
16bit as previous > check 'Regional Options and Language' as previous > Log in to Proplink
either by click the Proplink logo on the Desktop or by going Start > Programs > Multilink
Systems > Proplink > When Proplink opens for the first time you will need to link it to the
Server by >inserting Server Name where prompted in the top box > leave the bottom box as
is, unless you installed Proplink on to a different drive, in which case change the Proplink
path to match it > when completed check that all Multilink Systems programs are working
and then do a Transfer as previous.
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Multilink Systems - Install and Setup

INSTALLATION: on REMOTE LAPTOPS (i.e. Laptops that are being removed from the
office)

Open > My Computer > right click on Local Disk (C:) Drive > Properties > under the
'General' tab check that there is enough Free space = (1GB on server) > Check that the file
system is NTFS

Start > Control Panel > Display > 'Settings' tab > check that Color Quality = (Medium 16bit)
> 'Advanced' button > check DPI Setting = Normal Size > OK > OK

In Control Panel go to 'Regional and Language Options' > check that English (Australian) is
the default language. Also check in 'Advanced’, 'Set Default' button, 'Input Locales' tab, if
they are available.

Check 'All Programs' looking for 'RE Office' C:\macpro or 'reoffice' or 'borland'. If any of
these name appear please contact Multilink Systems before commencing Install.

If the Laptop is domicile in the office install Multilink Systems as a 'Workstation' same as
above. If you wish to remove the Laptop from the office and work remotely with it then use
the Install procedure below. A Remote Laptop exchanges information with the Office Server
by activating the 'Replication’ program (see explanation after the installation instructions
below.

Insert ‘Multilink Install Disc' > follow instructions making sure you activate the ‘Laptop’
radio button when the question is asked. Sometimes the installation says that there is not
enough room — ignore this and click "Yes'. Finish the Installation. Whilst the entire Multilink
Suite will be downloaded on to your Laptop only the Proplink and Scheduler modules will be
operational.

To activate the 'Replication’' program > Login to Proplink > Maintenance > Replication >
Transfer. When Replicating from the Laptop you have 3 choices
1. Download the information from the Server (this will accept the Server information as
being the 'true information'. If a record has been altered by the Laptop user and by
somebody else on the Server then the Server record will over write the Laptop record.
2. Upload the information from the Laptop (this will accept the Laptop information as
being the 'true information'. If a record has been altered by the Laptop user and by
somebody else on the Server then the Laptop record will over write the Server record.
3. Ask Me. If arecord has been altered by the Laptop user and has also been altered on
the Server then the Replication program will stop at that record and ask you which
record do you want to keep as the 'true information'.
IT ISIMPORTANT THAT THE SERVER AND EVERY WORK STATION AND
EVERY REMOTE LAPTOP HAVE IDENTICAL
e RECEIVE SETUP
e SHARING DEFAULTS

At the completion of the Installation please email info@multilink.com.au and ask for the
Forms requesting '‘Multiload Activation from Multilink Systems’. These forms will be
faxed or emailed to you and must be completed and forwarded to each Internet
Publisher prior to them accepting automatic uploads from your office.
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Multilink Systems - Install and Setup

2.1

SETTING UP THE MULTILINK SYSTEM

Proplink
Proplink (Property Link) is the core component of the Multilink System.

In its Sales Component you add your 'Current Listings', receive your 'Shared Listings', add your
'Potential Sellers', store your Sales History and insert your 'Buyers'.

In its Rental Component you add your 'Current Listings', receive your 'Shared Listings', add your
'Potential Landlords', store your Leased Properties and insert your 'Potential Tenants', and 'Relocation
Companies'.

Proplink matches Sellers with Buyers, it bulk-uploads to all of the major Internet Sites. It sends SMS
Text messages, electronic Brochures. It prints or emails - Stock-Sheets, Catalogs, Newsletters, Fact
Sheets of Current and Shared Listings. Plus, Sales and Rental History reports, Activity Reports to
sellers, OFI Lists, Potential Buyer Lists, follow-up Call Sheets. It compares Current and Shared
Listings against Recently Sold Properties. It sends Buyers to your Bankers, monitors Potential Sellers,
displays videos, photographs, 360 Degree Photos, Floor Plans and Vendor Statements.

Proplink can be networked within your office or installed on a Laptop (which includes a Replication
module, to stay synchronised with your office).

Proplink electronically sends and receives information enabling you to communicate with your Clients,
Suppliers and Strategic Alliances of your choice.

To set-up Proplink

Default Login is case sensitive

USERNAME is: admin

PASSWORD is: abcde

you can alter this anytime you want by

Login to Proplink > Maintenance > User Information > clicking on to > Edit > change the Password.
A Super User must always remember their password

Add New Users

Login to Proplink > Maintenance > User Information > New > User Name (insert first name of the
new user} > Rights. There are 3 different 'Rights’. 1.Super right - The highest right is the Super right.
A person operating with the Super right will have a total over-view. That is, they will access ALL
Buyers registered on the system when they click the Buyers button and ALL Potential Vendors when
they click the Potential Vendors button. For security purposes you should have only one Super User.
A Super user is the only user type that can open the 'User Information' button to register or delete
other Users. A User can only be deleted if they do not have any information remaining in any of their
databases. A Super user can over-write the Password of a sales person by clicking on to that sales
person's name then clicking the Password button and then over-writing that sales persons Password
with another password of their own choice. The Super right also allows the user to have connectivity
to other Multilink System 'Super User' modules such as Advertising Manager, Money and Research.2.
Salesperson right - Allows sales staff to choose their own Password. Whenever they Login to the
Multilink System using their User Name and Password the Buyer and Potential Vendors buttons etc.
will only return their own personal Buyers and personal Potential Vendors etc.3. Rent right - Allows
entry to the Multilink System Rental program. All Rent users have the same rights and can access All
information residing in the Rental Databases.

Your password can be anything you require it to be and can be changed by a Super User at any time
> when finished > Click on OK button.

info@multilink.com.au



SETTING UP THE MULTILINK SYSTEM 3

Agent Setup
When you first install Proplink you will be asked all of the questions in 'Agent Setup'. If at any time you
want to change any of the Agent information.

Login to Proplink > Maintenance > Agent Setup

Sharing Defaults - saves you having to insert these details every time you input a new listing

Select which other offices, branches or groups you want to share all of your listings with.

Login to Proplink > Maintenance > Sharing Defaults > Set 'Share List Type' to 'Alliances' > Click
on to radio button next to 'Alliances’ > If you want all of your listings to go to single offices, activate
the 'Office’ radio button. If you want your listings to go to a number of offices in the same Group,
activate the '‘Branch’ radio button. If you want your listings to go to your entire Group, activate the
'Group' radio button > select the Office, Branch or Group you want all of your listings to go to by
highlighting the name of the Office, Branch or Group and dragging it to the Alliance 1 box. If you want
your listings to go to other Offices, Branches or Groups highlighting the name of the Office, Branch or
Group and dragging it to the Alliance 2 box etc.

At the same time you can select which Distributors you want to send your listings to. Distributors are
normally any Internet site that publishes your listings.

In the 'Type' box click the 'Distributor’ radio button > a Distributor List appears on the screen >
highlight the name of a distributor and whilst keeping your finger pushed down of the left hand side of
your mouse drag the name into the 'Distributor 2' box (the 'Distributor 1' box should always have
'INTERNET' in it) > complete this exercise until all of your Distributors have their own Distributor box.

Receive Setup

You can choose what information you wish to receive and from what offices you wish to receive it. You
can elect to receive Current Listings and Sales History information from other Offices, Branches or
Groups or Postcodes of your choice.

To receive Current Listings from other offices

Login to Proplink > Maintenance > Receive Set-up > click the Current tab > activate the 'Office’,
‘Branch’, or 'Group' radio box > highlight the name of the office, branch or group and whilst keeping
your finger pushed down of the left hand side of your mouse drag the name into the 'Alliance 1' box
etc.

To receive Multiple Listed properties

Insert the Postcodes for which you want to receive Multiple Listed properties. You must have either a
specific postcode or a 'zero' entered in every postcode box *****If any of these postcode fields are
left empty, it will result in no information being received.

To receive Sales History information from other offices

Login to Proplink > Maintenance > Receive Set-up > click the History tab > activate the 'Office’,
'‘Branch’, or 'Group' radio box > highlight the name of the office, branch or group and whilst keeping
your finger pushed down of the left hand side of your mouse drag the name into the 'Alliance 1' box
etc.

To receive Sales History from other offices in addition to the nominated ones

Insert the Postcodes for which you want to receive Sales History information. You must have either a
specific postcode or a 'zero' entered in every postcode box*****|f any of these postcode fields are
left empty, it will result in no information being received.

By electing to receive Sales Information for these post codes you are also agreeing to send your sales
information. Please note that the sales information you will send and receive excludes the selling
agent's name and the purchaser and seller details.

A Super user can modify the 'Receive’ program at any time.

*** Every machine that has Proplink installed on it must have the Sharing Defaults and Receive
Setup (both Current and History) synchronised. Unless all machines are set up identically,
integrity will be lost when Transfers are done i.e. when a transfer is done from one machine it
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will instruct to Send and Receive one set of instructions and when a Transfer is done from
another machine it will issue another set of Send and Receive instructions.

Selecting your own default 'Trading Area' on your Contact Cards

When you first install Proplink the 'Map Areas' on the Contact Cards return the Australian Map. You
will first need to tailor this Map to your own trading area. To save you the time of having to replicate
this procedure each time you register a new buyer, the system always remembers the previous search
area and assumes that the next buyer you register will be wanting to purchase in the same areas that
you have nominated.

Login to Proplink > Contacts > Map Areas > Zoom In > position your mouse over your trading area
and then click the mouse > the screen will zoom down > reposition the mouse over your trading area
and click the mouse > the screen will zoom down further > reposition the mouse over your trading
area and then click the mouse > the screen will zoom down further > reposition the mouse over your
trading area and the click then mouse > the screen will zoom down further > if you are not happy with
the trading areas returned to your screen, click the Zoom Out button and return to the previous Zoom
Screen then click the Zoom In button > reposition the mouse over your trading area and then click
then mouse > you can redo this procedure as many times as you wish until you are happy with the
trading areas you have selected > when you are happy that you have your entire trading area on the
screen in front of you > Option > Select 'Set current map as default' tick box > OK > Select >
position your mouse cursor at the top left hand boundary of your trading area > left click on to the
mouse and whilst holding it down drag your cursor diagonally to the bottom right hand boundary of
your trading area > release your finger from the mouse (a rectangle should have formed on the
screen) > If you are happy with the result click OK > you will be returned to the Buyers Card and the
first six suburbs of the trading area you selected will be displayed on the screen - any additional
suburbs that you included will also be active even though they may not be displayed.

You can change the Map Areas any time you wish by repeating the above procedure. Remember - the
next buyer that you register will always be searching in the same area as the previous buyer.

Map Areas must be individually set up on each computer that uses Proplink.

To download the entire Proplink operating manual go to
www.multilink.com.au/downloads/proplink.pdf

Grouping Contacts

Set up your own Contacts and Group them any way you wish. Add Categories of your own choice. A
Contact can belong to just one or several categories at the same time. You may wish to Group your
Contacts into 'Buyer’, 'Purchased via other Agency', 'Tenant’, 'Vendor', 'Developer’, 'Corporate
Relocation', 'Landlord’, 'Supplier', 'Trades Person', 'Sales Person’, 'Solicitor', 'Financial
Adviser', 'Accountant’, 'Architects’, 'Town Planners’, 'Editors’, 'Other' , just to name a few

SMS Text Messages - Registration

Before you can send Text Messages you will need to register with a Acountant company that
distributes text messages to all of the mobile phone companies (Telstra, Optus, Vodaphone, Virgin,
Orange etc.) We recommend Xacom Pty Ltd (03) 9574 8777. When you send your first text message
you will be asked to insert a password. The password will be supplied by Xacom when you register.
All subsequent text messages will not require the password.

Multi loading to all Internet Sites - Registration

To simultaneously load, update and remove information from all the internet sites that you use you will
first need to inform all the sites. An email to the Internet Host will usually suffice but realestate.com.au
requires a form to be faxed to them. The form is available from Multilink (03) 9425 9400Accountant

info@multilink.com.au
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2.2  Advertising Manager

Advertising Manager keeps you up to date with all of your Marketing Expenditures. It keeps you on
track and on Budget.

To set-up Advertising Manager
Only Super Users have access to this program.

Login to Advertising Manager

1. Media Set up

The word Media represents all advertising done through the newspapers. The Media Set-up screen
allows the user to set up all the advertising media they use and their "Casual" and "Company" cost.
The different media newspapers and the various advertising days are set-up by Day (relating the
advertising costs applicable for that day). Every separate Column Heading within the same media
requires a new row, e.g. Age HFS, Age OFI. Age OYO etc. Click the New button to add a new row.
In the Address Column place the address of the selected newspaper. In the 'Lineage Casual' column
place the casual per line cost applicable to that day. In the Lineage Contract column place your
contracted cost per line applicable to that day. If your company divides your display-advertising page
differently to the way the Media invoices for that page then these divisions are called Units. Insert the
cost of a single unit in the Unit column.

In the Display Casual column insert the Casual Cost per column centimetre charged by the Media. In
the Display Contract column place your negotiated Contract Rate per column centimetre.

This is the Master Template from which all advertising media costs are calculated and can be modified
as required.

2. 'Media Schedule' Templates

'Media Schedule' Templates allow you to create as many Media Schedules as you wish. Creating a
series of Media Schedules eliminates the need to individually set up every advertising campaign.
Once created they can be printed and given to the sales team or imported into the advertising
schedules of newly listed properties. Click your mouse onto the New Schedule button and insert a
name for the Schedule e.g. $1000 Schedule. Now click the New Media button. An empty row will
return. One click in the empty Media cell will allow you to manually type in the name of any media.
Double clicking in the empty Media cell will return the Media Choice previously set up in Media Set-up.
Select the Media required by clicking on to it. On the keyboard hit the Tab key to proceed to the next
column. Select the Day on which you wish the advertisement to appear. Key Tab to the next Predicted
Size column and type in the size of the advertisement required.

Typing the letter L next to the number of lines will instruct Advertising Manager to calculate the cost
based on the per line rate of the selected Media for that day. Example 13L = 13 lines

Typing the letter U next to the number will instruct Advertising Manager to calculate the cost based on
the number of advertising units used by the advertisement. A unit relates to the way your company
uses the Media advertising space, which may not necessarily be the way the advertising space has
been charged by the Media. Example 2U = 2 units

Typing x between 2 figures (with no spacing in between) will instruct Advertising Manager to calculate
the cost based on the rate per column centimetre for Display Advertising. Example 3x2 (with no
space)= 3 columns x 2 cms.

Repeat the above procedure per row until your standard Media Schedule has been completed.
Click New Schedule button and then repeat the above procedure to create as many Media Schedules
as you wish.

The Print Schedule button will print out any nominated media schedule allowing a sales person to take
that schedule with them on a Listing Presentation.
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2.3

3. 'Other Schedule' Templates

If it is not a "Media" expense then it must be an "Other" expense.

Place all of your 'Other' Expenses that may relate to an advertising campaign e.g. all the different
sizes of For Sale boards, Window Displays, Pointer Boards, Sketches, Brochures etc. and their
corresponding costs in this Template. Print this Report and take it with you on a Listing Presentation.
After you have chosen a Media Schedule you can nominate which other advertising expenses your
seller requires by simply placing a tick against each nominated expenditure.

Once you have completed the 'set up' of the various Advertising Manager Templates, the work
involved in processing the Predicted and Actual advertising will be reduced to only minutes per week.

To download the Advertising Manager operating manual go to
www.multilink.com.au/bill/advertisingmanager.pdf

Money

Money runs your Sales Trust Account and General Account Cashbook. It also manages the
Commissions and sales Team remuneration.

To set-up Money
Only Super Users have access to this program.

Login to Money > Trust Account > New > in the new row

in the date column > Click the Date icon = insert date>

in next column 'Type' = click the drop down box > select Credit = insert your next Trust Account
Receipt Number or Debit = insert your next Trust Account Cheque Number (from hereon the following
Receipt and Cheque numbers will be automatically numbered) or' Dir Credit' and 'Dir Debit' are for
credits and debits inserted directly by the bank or 'Xfer Credit' and 'Xfer Debit' are for internal journal
transfers

in next column 'Payee’ insert the Payee Details

in next column 'Payment' insert amount or 'Deposit’ insert amount

in next column 'Category' double clicking opens the index of Trust Account ledgers > activate 'From
Existing Ledgers' radio box > if it is a new ledger insert the address in the 'New' box > Done

in next column 'Memo' double click to insert an explanation or type in your own explanation

Login to Money > General Account > New > in the new row

in the date column > Click the Date icon = insert date >

in next column 'Type' = click the drop down box > select Credit = insert your next General Account
Receipt Number or Debit = insert your next General Account Cheque Number (from hereon the
following Receipt and Cheque numbers will be automatically numbered) or' Dir Credit' and 'Dir Debit'
are for credits and debits inserted directly by the bank or "Xfer Credit' and 'Xfer Debit' are for internal
journal transfers

in next column 'Payee’ insert the Payee Details

in next column 'Payment' insert amount or 'Deposit' insert amount

in next column 'Category' double clicking opens the index of General Account ledgers > activate 'From
Existing Ledgers' radio box > if it is a new ledger insert the Category in the 'New' box > Done

in next column 'Memo' insert an explanation of the credit or debit

To download the Money operating manual go to
www.multilink.com.au/bill/money.pdf
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SETTING UP THE MULTILINK SYSTEM 7

2.4 Presentations

Presentations is a word processing program . It contains your Sales and Rental letter libraries. It has
mail merge facilities and imports photos into its reports.

To set-up Presentations

The Multilink System 'Presentations’' program comes with several generic letter libraries that can be
added to or changed at any time. The libraries refer to Sales Properties or Rental Properties and
are divided in to 'Pre Listing', 'Current Listing' or 'Post Listing' activities. Some States allow Home
Owner information to be downloaded. If this information is available in your State, the Home Owner
Directory enables you to search for Absentee Owners in your trading area. The Sales Directory
reads information supplied by the Valuer General.

To add a new letter to the Letter Library

Login to Presentations (if you Login as a Sales Person it will return the Sales Letter Library, if you
login as Rent it will return the Rent Letter Library) > activate 'Letters First' > Potential Vendor
(Current Listings or After Sales, Homeowner Directory, Registered Customers etc.) > Add > insert the
name of the new letter > OK > the New Letter Name will now be returned to the screen > Open >
Paste in a copy of the letter you want to have or type in the new letter (leave spaces to insert the
merger fields)

To insert the Merge fields

In the Multilink Database, the 'Field Names' for both Rentals and Sales are the same. As a result
wherever the Merge Field refers to 'Purchaser' that Merger Field will return the "Tenant' details and
wherever the Merge Field refers to 'Vendor' that Merge Field will return the 'Landlord' details in your
Tenant letters.

Place the cursor on the location you want to see the 'date’ to appear > Insert (on menu bar) > select
Agent Fields > select 'Today' from the drop-down-box > OK.

All merge fields relating to the estate agent are located in 'Agent Fields'. All merge fields relating to
the property, sellers, buyers etc are located in 'Merge Fields'

Inserting a Table, Image or Object are all individual activities and can only be done when you are
actually preparing a document.

Insert a separate letter library in each one of the Potential Vendor or Current Listings or After Sales or
Registered Customers (Buyer's Register) or Homeowners Directory (Voters Roll) or Sales Directory
(Valuer General downloads in CMA) > Add as many letters to each letter library as you wish

To activate any letter template in any of the Letter Libraries (including their merge fields)

Login to Presentations > activate the 'Letters First' radio box > select Potential Vendor or Current
Listings or After Sales or Registered Customers (Buyer's Register) or Homeowners Directory
(Voters Roll) or Sales Directory (Valuer General downloads in CMA) > select the letter you require by
clicking on to it > Listing > search for the property or person that you wish to send the letter to >
Open

To download the Presentations operating manual go to www.multilink.com.au/bill/presentations.pdf

2.5 Research
Research collects information from other modules in the Multilink Suite to create the following reports:

Key Performance Indicators: which monitors the performance of every member of your sales team.
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2.6

It reports back on their activity on the key areas of Customer Communication, Property Introductions,
Inspections, Buyer Registrations, Closings etc.> It also reports on how many new leads were received
by each sales person in a selected time frame and how many Current Listings, Potential Sellers and
Buyers they are working with.

Buyer Demographics: which monitors which suburbs your registered Buyers currently live in (it
breaks your buyer groups into price ranges).

Referrals: which identifies the Buyers who are registered with you who may be Potential Sellers in
another Trading Area. Agents can activate this program to begin an exciting 'Referral' program with
other agents in other locations.

New Listings: which can be used to reference or for Property Runs after a Sales Meeting. The New
Listings report can also include Shared Listings if you require.

Recent Sales: which reports on Sales Turnover including the List Price verses Selling Price and
logging 'How many days that property was on the market'

To set-up Research
Only Super Users have access to this program.

Login to Research > Buyer Demographics > Add Prefix > Add > Insert the telephone prefix and
the suburb that each prefix belongs to > there may be several telephone prefixes for a single suburb.
To consolidate these prefixes and suburbs click Summary

To download the Research operating manual go to www.multilink.com.au/bill/research.pdf

Scheduler

Scheduler enables a Sales Person or Personal Assistant to plan their day, scheduling Recurring
Tasks (that need to be performed on a regular, daily, weekly or monthly basis) and scheduling the
management of Buyers, Sellers, Potential Sellers, Current Listings and Previous Sales. Scheduler
comes with a set of generic Action Plans that can be altered to suit any situation. Once activated
these Action Plans remind the sales team and administrators of every task to be done on a daily
basis. Scheduler eliminates ‘crisis management' and automates procedures for both the sales team
and office staff. The "In-process" controls guarantee that the scheduled tasks are completed.

Scheduler also centralises those '‘one-off' messages and reminders from sales staff relating to any of
their Buyers or Sellers.

To set-up Scheduler

Plan the actions you want to take for a 1)Potential Seller, 2)Current Listing, 3)After Exchange
(before Settlement) > 4)History (after Settlement).

Most of these actions will be standard and can be pre-set, but some actions may be specific for an
individual circumstance and can be added to a plan when the time comes.

To Setup your Standard Plans for each of the 4 states above

Login to Scheduler > Setup >

Pre Listing > Add > type in the Pre Listing task you wish to perform > insert how many days into this
plan do you want to be reminded to do this task > Add > insert the next task and the number of days
into the plan you want to be reminded to do it. etc.

Current Listing > Add > type in the Current Listing task you wish to perform > insert how many days
into this plan do you want to be reminded to do this task > Add > insert the next task and the number
of days into the plan you want to be reminded to do it. etc.

After Exchange > Add > type in the After Exchange task you wish to perform > insert how many days
into this plan do you want to be reminded to do this task > Add > insert the next task and the number
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of days into the plan you want to be reminded to do it. etc.

History > Add > type in the After Settlement task you wish to perform > insert how many days into
this plan do you want to be reminded to do this task > Add > insert the next task and the number of
days into the plan you want to be reminded to do it. etc.

There are other actions that need to be performed in a real estate office on a recurring basis e.g
Monday - insert Auction results from the weekend, Thursday - insert Daily Newspaper advertising etc.
etc. In your Multilink System 'Stationery Cabinet' you have a Recurring Daily Tasks proforma
document to help you with this setup.

When a Recurring task has been completed it must be rescheduled for the following week etc.

To setup Recurring Tasks

Go to Scheduler Main Menu > Recurring Tasks > Add > type in the Recurring task you wish to
perform > insert the date you want this task to be next performed > Add > type in the next Recurring
task you wish to perform > insert the date you want this next task to be next performed etc.

Schedule Transfer, allows outstanding tasks to be transferred between sales staff in the event of a
member of staff resigning or being away.

To download the Scheduler operating manual go to
www.multilink.com.au/bill/scheduler.pdf

2.7 CMA

CMA stands for Comparable Market Analysis and Competitive Market Analysis. CMA is
automated and quickly creates is a professionally compiled Valuation Report that compares a
Potential Listing against other properties that have recently been sold, or against other Listings
currently for sale that would be competing with that Potential Listing for buyers.

To set-up CMA

Comparable Market Analysis

This program helps you to analyse the value of a 'Potential Vendor' property filed in Proplink against
other sold properties filed in Proplink's 'Sales History'. You can also compare that same 'Potential
Vendor' property against other 'External’ sold property information that has been downloaded from the
Valuer General or from your Real Estate Institute.

Competitive Market Analysis
This program helps you to analyse the value of a 'Potential Vendor' property filed in Proplink against
other 'Current Listings' and 'Shared Listings' that are competing against that property for buyers.

There is no Setup required to operate the CMA program.

To find out how to download 'Sales Information' from the Valuer General or from your Institute go to
the 'Downloading Valuer General sales info into CMA' topic found in 'The Dynamic Personal
Assistant'. To get to 'The Dynamic Personal Assistant'. Click Start on the Microsoft Task Bar >
Multilink Systems > Success - enter here > 'The Dynamic Personal Assistant'

2.8  Design Studio

The Design Studio allows you to instantly produce full colour
Local Paper Ads
- Window Displays
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2.9

2.10

- Brochures

- General Flyers

- "Just Sold' photographic Flyers
- 'Just Listed photographic Flyers
- Newsletters

- Contact Cards

- or any other Graphic Output

you will need to contact Multilink Systems with specific design and layout instructions and receive a
guote to have the tailored files you require loaded on to your desktop

Electronic Listing Presentation

The Multilink Electronic Listing Presentation is an interactive graphic presentation that is performed
in front of a potential seller.

Before the presentation, the potential listing is photographed (from the outside) and loaded into
Proplink as a Potential Vendor. At the presentation the potential sellers can compare their property
against other recently sold properties. They can then view currently listed properties that will be
competing against their property for buyers. The sales person can quickly retrieve a 'Buyer's List' of
registered potential buyers their company has currently registered in the price range of the potential
listing and can demonstrate how their company bankers can obtain better finance that will convert into
a higher sale price.

The electronic listing presentation demonstrates who the company electronically alerts potential
buyers via SMS Text messages and electronic e-brochures and also how their property can be
distributed to the databases of strategic alliance offices in their network plus Corporate relocation
Companies and Investment Advisers.

The Potential Seller can easily see what advertising generates the best enquires and can in what
suburbs their likely buyers are currently living.

The Electronic Listing Presentation concludes with corporate video of your company and its
successes.

There is no set-up to the Multilink Electronic Listing Presentation because it reads directly from the
programs in the Multilink Suite.

Tools

The Tools program manages the Multilink System. 'Tools' can only be accessed by a Super User
(see Proplink Setup)

Multilink System comes with some Standard Settings that can be adjusted at any time the user
requires. These Standard Settings are located in the 'Tools' program and are as follows.

When a 'Buyers Card' searches for matching properties registered in 'Current Listings' and
'Shared Listings'

When a Buyer registers in Proplink the 'New' 'Found' and 'Other’ results that are recorded
automatically at the bottom of the Card, reflects the result of the search. The Price Formula of the
search is as follows:

The 'Asking Price' of 'Private Sales' registered in both the 'Current Listings' and 'Shared Listings'
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modules, that are up to 20% above the 'Price To' amount recorded on the 'Buyers Card', down to 90%
of the 'Asking Price' of the 'Private Sales' properties

and

The 'Auction Quote Price' of 'Auction Sales' registered in both the 'Current Listings' and 'Shared
Listings' modules, that are up to 5% above the 'Price To' amount recorded on the '‘Buyers Card' down
to 75% of the 'Price To' amount recorded on the 'Buyer's Card'

will be returned

When a 'Private Sale' registered in 'Current Listings' or 'Shared Listings' searches for matching
buyers

When a property listing is registered as a 'Private Sale' in either of the 'Current Listings' or 'Shared
Listings' modules in Proplink and you want to search for Buyers that may match with that property, the
Standard Formula for this search is as follows

Buyers Cards that have a 'Price To' recorded, that is equal to the 'Asking Price' of the Private Sale
down to 80% of the "Asking Price' of the 'Private Sale', will be returned

When an 'Auction Sale' searches for matching buyers

When a property listing is registered as an 'Auction’ in either of the 'Current Listings' or 'Shared
Listings' modules in Proplink and you want to search for Buyers that may match with that property, the
Standard Formula for this search is as follows

Buyers Cards that have a 'Price To' recorded, that is up to 20% higher than the 'Auction Quote Price'
down to 90% of the "Auction Quote Price', will be returned

Advertising File Ref.

When you Delete a file from Advertising Manager, the Multilink System will automatically print out a
report and assign a 'Deleted Reference Number'. This reference system can be reset at any time you
wish. All deleted advertising references should be kept in a special folder and checked that all
reference numbers are sequential. This is a security check.

Internet Setup
Should say multilink.com.au

Show Vendor Information
Tick this box if you want the Vendor's information to be displayed on the main pages of Current
Listings and Shared Listings

Detailed Buyer Introduction
Tick this box if you want detailed information to be inserted against a Buyer when you click
'Introduced' on the Buyer's Search results

2.11 Bulk Messaging

'‘Bulk Messaging' enables you to send messages to any humber of Contacts at the same time. The
possibilities are endless.

1. You can export a 'Merge List' from Proplink to a Source File and then integrate that Merge List into
a Document for printing.

2. You can export mobile phone numbers from Proplink, create a message, then send that message
via SMS Text, to those mobile numbers.

3. You can create a 'Merge List' from Proplink and email any 'html template' you wish to that merge
list.

Examples of 'html Templates' are.
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A 'Welcome to a New Property Seeker' sent to every buyer that registers with your company

A 'New Listing Catalog' sent to your Buyer Database every week.

A 'Buyer Update' query sent to your '‘Buyer Database' once a month asking if they are still
active buyers.

A 'Recent Sales Catalogue' sent to your 'Potential Vendors'.

A 'Congratulations on your Purchase' message sent to your buyers who have purchased
through another agent.

A regular 'Newsletter' to every Category in your database.

A response to the '1300 tele-link' prospecting leaflet
e Regular communications to 'Potential Sellers'

These 'html Templates' usually have Ancillary Documents or Links that are attached to them. These
links can be 'Static' i.e. they stay constant OR they can be 'Dynamic' i.e.they are constantly changing.
Suggestions for 'Static Links' are
e Your Mortgage Originator
A choice of Solicitors
A choice of recommended 'Furniture Removalists'
A message about your 'Rental Department'
'Pre Settlement' check list
Change-of-Address info
e etc.
Suggestions for 'Dynamic Links' are
¢ 'Recently Sold Properties'
'Recently Leased Properties'
'New Listing Catalogue' from your Current Listings
¢ 'New Listing Catalogue' from your Shared Listings
e 'Current Buyers' lists
the 'Dynamic’ links are ".pdf' files and need to be updated constantly so that your 'html' communication
stays current.

Obviously it is much cheaper, simpler and more convenient if you can communicate the Bulk Message
via email instead of printing and posting.

So, to manage the Bulk Messaging process via email you need to have 3 components
1. A Web Hosting Service
2. The 'html templates' (containing your Messages plus their Merge Fields)
3. The Ancillary Documents or Links.

BULK MESSAGING VIA EMAIL

The following email 'html templates' already found in Bulk Messaging and their purposes are

e 'Welcome to a New Property Seeker' sent every day to all new buyers that register with your
o 'New Listing Catalog' keeping your buyers up-to-date with New Listings and t
e 'Buyer Update' sent monthly to all Buyers to update your database

e 'Congratulations on your Purchase' sent to all buyers (even if they have purchased through
e 'Newsletter’ sent to every Contact in your database

e '1300 tele-link’ sent to all people who respond to your '1300' leaflets
e 'Potential Sellers' sent regularly to all Potential Sellers

these templates can be easily tailored to suit your company and your locality. Tailoring to your
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locality is important if you want your communications to be interesting. Centralised 'generic'
messages are boring and do not get read!

Setting-up your Bulk Messaging emails

1. For an annual cost of $110 Multilink will setup a web server host for you and place your html email
templates on to that host. When this is completed

2. Multilink will email your html templates. There are 6 basis email templates to start you off. You can

add as many as you wish. The 6 email templates all have names they are.
welcome_email.htm

new_listings_email.htm
congratulations_email.htm
buyer_verification.htm
homelink.htm

Potential_Seller_email.htm

When you receive the email from Multilink Systems that contains the Multilink Bulk Messaging email
templates, follow these steps. Open the link by clicking onto it
2.1 Click 'Run'
2.2 In the 'Unzip to folder' box type c:\multilink_frontpage_web
2.3 Click 'Unzip'
2.4 Click 'OK'
2.5 Click 'Close'
You have now downloaded the Multilink Bulk Messaging email templates on to your desktop. This
computer should be where you will be doing the editing and must also have Microsoft Front Page
2003 or later installed.
If you do not feel comfortable doing your own editing any competent graphic designer would be able to
do the editing for you.
3. Link these edited html email templates to your web server host.
a. To create this link Multilink will supply you with an IP Address, Domain Name, User Name and
a Password.The html email templates you receive from Multilink will be web server host
compatable when you receive them. However, you will need to insert your IP Address into the
Multilink Bulk Messaging program to link them with your web server host. To do this
b. Open 'Bulk Messaging' -> emails -> click Add button in category column. Create a category
(e.g. Buyer Management) -> click OK. Click the Add button in name column. Insert the name
of the first email template (e.g. Welcome a New Buyer). In the 'Internet Address URL' box,
insert http://lyour ip address/domain name/email name (e.g.
http://66.98.254.30/richmond.com/welcome_email.htm). Repeat this process until all of
your html emails have been entered into Bulk Messaging. Whatever you insert in the 'subject’
box will appear in the subject box of the email you send. Suggested Bulk Messaging setup
could look like this. If you use this format, remember to edit the URL Address and Domain
Name
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NAME INTERNET ADDRESS SUBJECT
(URL)
Welcome a New Buyer  http://209.42.210.70/buxton.com Buxton Real Estate Welcomes a
/welcome_email.htm new Property Seeker
New Listing Catalogue' & http://209.42.210.70/buxton.com Bayside Property Update
Market Update /new_listings_email.htm
Purchased through http://209.42.210.70/buxton.com Congratulations on your
External Agent /congratulations_email.htm Property Purchase
Monthly Buyer http://209.42.210.70/buxton.com Have you changed your
Verification /buyer_verification.htm requirements?

Homelink Newsletter http://209.42.210.70/buxton.com Buxton's Homelink Newsletter

/homelink.htm

Local Neighbourhood http://209.42.210.70/buxton.com Local Property Update
Property Update /Potential_Seller_email.htm

c. Once you have added all of the 'Bulk Email' templates, test them by double clicking on to the

URL Address. If the Internet URL Address opens the html email then register yourself in
Proplink Contacts and then in Bulk Messaging search for your name, then click Emails,
choose the correct html template, and click Send.

4. Open Microsoft Front Page and edit the email templates

To open the Bulk Messaging email template file in front page > file > open site > my computer > go to
c:\multilink_frontpage_web > double click > single click on folder > open > navigation > open pages
and edit. If you are unfamiliar with Front Page you can attend regular training sessions conducted by
Multilink Systems or contact Multilink Systems for a price to update your Bulk Messaging email
templates for you.

If you do not have Microsoft Front Page, and you wish to do your own editing, there is another

'Free' program that does a similiar job as the 'Front Page' program. This Free program is
called 'Composer'. To download Composer see below.

Troubleshooting
"My images are not appearing at the recipient's end"

1. Make sure you published the page (see above instructions)

2. After the page is saved and published > right click onto the page > a 'right click' dialog box
will appear > select 'Page Properties > a 'Page Properties dialog box will appear > Copy the
information in the 'Location’ box and paste it into the 'Base location' box.

Download 'Composer’

If you do not have Microsoft Front Page on your computer there is a FREE program you can download
from the Internet.

1.
2.
3

Download Mozilla (which includes Composer) at http://www.mozilla.org/products/mozillal.x/
Install it by following the instructions on the screen.

Start Composer by going to Start->Programs->Mozilla->Mozilla and then Window-
>Composer.

Customize all templates to suit your company's web/graphics design by opening the email
templates, (use File->Open File).

After editing, publish it to your web server host site by using File->Publish. The first time you
Publish you will be asked to complete the following. When completed tick the box to
remember and save your password. These settings will then be remembered

Next to the following boxes below You will need to insert below

SITE NAME multilink_web_template
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PUBLISHING ADDRESS ftp:/lyour ip address/%2f/var/iwww/html
HTTP ADDRESS http://your ip address/your domain name
USER NAME as supplied by Multilink
PASSWORD as supplied by Multilink

Your ip address,
your domain name, your user name and your password, will all be supplied by Multilink when
you received your Bulk Messaging email templates.

6. Repeat this editing and publishing process for each of the 6 Bulk Messaging email templates
.htm files. You will not be asked to enter the publishing address, username and password
which were provided by Multilink when you signed up because Composer remembers it from
the first time. However each time you Publish a 'Publish Page' dialogue box will appear. You
do not need to add anything to this box except untick "Include images and other files" before
you click the Publish button.

7. Once all of the 'Bulk Email' .htm Templates edited in the Web Server you will need to Add
their respective addresses to the Multilink Bulk Messaging program by using Start->Multilink-
>Bulk Messaging->Emails.

8. You now need to link these emails that are on the web server, to your Bulk Messaging
program.

9. See 3b above

Now that you have the HTML Email Templates ready to go you will periodically need to change the
Dynamic .pdf attachments.
Suggested .pdf attachments that you may wish to link to your email bulk messages are:

'Recently Sold Properties'

'Recently Leased Properties'

‘New Listing Catalogue' from your Current Listings
'New Listing Catalogue' from your Shared Listings
'‘Current Buyers' lists

How To Create a 'Recently Sold .pdf Catalogue'

Proplink > Sales History > Search for Recently Sold Properties between dates that you specify > when
the search is returned > hold the 'Ctrl' key down and click on to the properties you want in the report >
Print > in the "Which Properties' panel activate 'Selected' > In the 'Print Format' panel activate 'Catalog'
in the 'Sort By' panel activate whichever 'radio box' you require > in the 'Custom Title' panel activate
the tick box and type in 'Recent Sales' > Print > click the Printer Icon > activate 'Print to File' > in the
"Type' box scroll down and then select 'PDF File' > in the 'Where' box click the '..." button and locate
the 'Email Links' folder > OK > insert the file name > Save > OK > Close > Exit

How To Create a 'Recently Leased .pdf Catalogue'

Login to Proplink using Renta status > Leaded History > Search for Recently Leased Properties
between dates that you specify > when the search is returned > hold the 'Ctrl' key down and click on
to the properties you want in the report > Print > in the '"Which Properties' panel activate 'Selected' > In
the 'Print Format' panel activate 'Catalog' in the 'Sort By' panel activate whichever 'radio box' you
require > in the 'Custom Title' panel activate the tick box and type in 'Recent Sales' > Print > click the
Printer Icon > activate 'Print to File' > in the 'Type' box scroll down and then select 'PDF File' > in the
'Where' box click the '..." button and locate the 'Email Links' folder > OK > insert the file name > Save >
OK > Close > Exit

To Create a 'New Listing .pdf Catalogue’ from Current Listings

Proplink > Current Listings > Search for New Listings > when the search is returned > hold the 'Ctrl’
key down and click on to the properties you want in the report > Print > in the 'Which Properties' panel
activate 'Selected' > In the 'Print Format' panel activate 'Catalog’ in the 'Sort By' panel activate
whichever 'radio box' you require > in the 'Custom Title' panel activate the tick box and type in 'New
Listings' > Print > click the Printer Icon > activate 'Print to File' > in the 'Type' box scroll down and then
select 'PDF File' > in the 'Where' box click the '..." button and locate the 'Email Links' folder > OK >
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insert the file name > Save > OK > Close > EXxit

To Create a 'Shared Listing .pdf Catalogue' from Shared Listings

Proplink > Shared Listings > Search for New Listings > when the search is returned > hold the 'Ctrl'
key down and click on to the properties you want in the report > Print > in the "Which Properties’ panel
activate 'Selected' > In the 'Print Format' panel activate 'Catalog’ in the 'Sort By' panel activate
whichever 'radio box' you require > in the 'Custom Title' panel activate the tick box and type in 'New
Listings' > Print > click the Printer Icon > activate 'Print to File' > in the 'Type' box scroll down and then
select 'PDF File' > in the '"Where' box click the '..." button and locate the 'Email Links' folder > OK >
insert the file name > Save > OK > Close > Exit

To Create a 'Current Buyers .pdf List'

Proplink > Contacts > activate 'Buyers' insert a price range (buyers lists become extensive, so it is
better to divide the Buyers List in to 3 or 4 different Price Ranges) > Search > when the search is
returned > Print > click the Printer Icon > activate 'Print to File' > in the 'Type' box scroll down and then
select 'PDF File' > in the 'Where' box click the '..." button and locate the 'Email Links' folder > OK >
insert the file name > Save > OK > Close > Exit

The above .pdf files will be linked to your Email Templates.

To attach (link) the above .pdf 'Links' to your email 'Principal Templates'

1. Create the .pdf file you require (see above)

2. Create an 'Email Link' address' for that file: to create this I'ink address' ->

Proplink > Maintenance > Attachments > Add > locate the 'Email Links' folder you created (see above)
> select the .pdf file that you require > Open > check that the 'Email Link' file name appears on the
'‘Attachments' screen > Exit > Transfers > Transfer (this will send your 'Email Link' to the Internet and
return an 'Internet Link Address' for that 'Link Document' to your local computer ) > when Transfer is
finished > Exit > Attachments > highlight the 'Link Document' name on the 'Attachments' screen > Get
Link > highlight the 'Internet Link Address' > right click on mouse > copy > go to the Microsoft Front
Page or Composer > go file->open site. browse to "My Documents"->"My Web Sites". single click on
proplink_emails2. click open > click navigation tab at the bottom of window > open the Email Template
.htm file you require > right click on to the 'click here' position that opens the link you want to edit > a
right click menu will appear > Hyperlink Properties > in the Address Box replace the existing address
with the new address copied from Proplink Attachments

This link will stay with this Email Template until you change it

BULK MESSAGING VIA PRINTED 'SURFACE MAIL'

You need to set-up 2 folders on your computer. The first folder named 'Merge Lists' (contains the
information you wish to merge into your templates e.g. the customer's names, addresses etc.) and the
second folder named ‘'Templates' (contains the message you wish to send to your customer base -
into which your customers names, addresses etc. will be merged).

These 2 folders should reside in another folder called '‘Bulk Messaging'

If you are Bulk Messaging via printed 'Surface Mail' what is a 'linked" .pdf file in an email message
must be printed separately and added to your mail-out envelope (if you wish to include it with your
message).

How To Create a printed version of the 'Recently Sold Catalogue'

Proplink > Sales History > Search for Recently Sold Properties between dates that you specify > when
the search is returned > hold the 'Ctrl' key down and click on to the properties you want in the report >
Print > in the 'Which Properties' panel activate 'Selected' > In the 'Print Format' panel activate 'Catalog'
in the 'Sort By' panel activate whichever 'radio box' you require > in the 'Custom Title' panel activate
the tick box and type in 'Recent Sales' > Print > click the Printer Icon > select the printer and print the
report.
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How To Create a printed version of the 'New Listing Catalogue'

Proplink > Current Listings > Search for New Listings > when the search is returned > hold the 'Ctrl’
key down and click on to the properties you want in the report > Print > in the 'Which Properties' panel
activate 'Selected' > In the 'Print Format' panel activate 'Catalog’ in the 'Sort By' panel activate
whichever 'radio box' you require > in the '‘Custom Title' panel activate the tick box and type in 'New
Listings' > Print > click the Printer Icon > select the printer and print the report.

How To Create a printed version of the 'Shared Listing Catalogue'

Proplink > Shared Listings > Search for New Listings > when the search is returned > hold the 'Ctrl’
key down and click on to the properties you want in the report > Print > in the 'Which Properties' panel
activate 'Selected' > In the 'Print Format' panel activate 'Catalog’ in the 'Sort By' panel activate
whichever 'radio box' you require > in the 'Custom Title' panel activate the tick box and type in 'New
Listings' > Print > click the Printer Icon > select the printer and print the report.

How To Create a printed 'Current Buyers List'

Proplink > Contacts > activate 'Buyers' insert a price range (buyers lists become extensive, so it is
better to divide the Buyers List in to 3 or 4 different Price Ranges) > Search > when the search is
returned > Print > click the Printer Icon > select the printer and print the report.

How To create a '‘Merge List' to insert into your printed documents.

Bulk Messaging > Search > insert your search criteria > Search > when search results are returned >
Export To Merge File > Select > locate 'Merge Lists' > insert 'File name' > Save > Start Export > OK >
close Bulk Messaging program.

How To create Templates for printing

Open Microsoft Word > type the message you wish to send to: a) a New Buyer: b) Your Buyer
Database (containing your New Listing Catalog): ¢) A Buyer who has Purchased through another
agent: etc.> Save each Message in your 'Templates' folder.
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